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The Windows based set-up program is menu driven, allowing the user 
to easily view data, alter set-up variables or set machine timing 
(machine offset, timing signal locations, etc.), using a PC running the 
Windows (95/98/ME/2000/XP/NT) operating system. The set-up 
variables are used to configure and tune the M4510 to match the 
configuration and performance of the specific bodymaker (see section 
2.9 – HSL-WISVCUP Set-Up). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4510 module.  The data displayed and set 
in the windows is communicated directly to the module, while in the 
“Online” edit mode. Therefore, prior to going online with the 
processor, make sure an RS-232 cable is connected from the COM 
port on the computer to the "PROG" or “MOTION” port on the 
M4510.  The variables displayed while in the “Online” edit mode are 
read directly from the processor.  Data is saved to a “Set-up Data” file 
(*.sdt) whenever changes are made to a parameter or if the data is 
uploaded from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed under the “Edit” menu. 
 
Getting Help:  The entire contents of the user’s manual is contained 
within the help file.  Pressing Ctrl+H will display the help file 
window.  Pressing the F1 key will display the contents file.  Hot spots 
allow jumps to other topics to display additional information as 
desired.  Selecting About WISVCUP from the Help menu will display 
a dialog box listing information about the current revision of the setup 
program and how to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to 

the processor. 
• Print a Report of the current set-up parameters. 
• Exit the set-up program. 
 

 
 
 



SECTION 4 
WISVCUP - WINDOWS BASED  
SET-UP PROGRAM REFERENCE 

 
HSL-WISVCUP User’s Manual SYSTEMS Electronics Group 

 
- 38 - 

________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however, the data tables will not be properly aligned.  
The user will be alerted to the problem if a set-up data file has been 
created by either a different set-up program or a different revision of 
the software. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program first starts, a default file is loaded and the user is 
able to make any changes as desired.  The set-up program is unaware 
of the settings and parameters that exist within the processor.  
Therefore, to normalize the set-up program, the user should define or 
open an existing file, then upload “All” variables from the processor.  
This allows the user to either create a backup of the data or maintain 
an existing file.  The user can even open a data file for another 
bodymaker, save the file to a new name, make the necessary changes 
and simply download the new parameters to another processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box allowing the 
user to select a folder and enter a name for the file.  The user will be 
notified if the file already exists and the extension “.sdt” will 
automatically be added to the file name.  If this is a “New” file, the 
user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user 
to select a folder and enter in a new name for the file.  The user will 
be notified if the file exists and the extension “.sdt” will automatically 
be added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
 
 
________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload blow-off parameters, 
timing channel set-points and shift data from the M4510 and S4520 
into a set-up “Data File”.  This function is accessed from the “File” 
menu and the user is given the choice of the following options: 
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M4510 PLC:  This option uploads (reads) set-up parameters, 
machine timing set-points and shift data from the M4510, only. 
 
S4520 Motion Control:  This option uploads (reads) set-up and 
tuning parameters from the S4520 Motion Control Board, only. 
 
 
________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to either the M4510 or S4520. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
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Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4510 PLC SYSdev 
file can be downloaded through the set-up program.  Care should be 
taken when selecting a program to download. 
 
Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.  After 
the user confirms their choice, program download is initiated and the 
current program download address is displayed.  When program 
download is complete, the user is prompted to acknowledge.  Control 
is passed back to the main program and the set-up program remains in 
an “Online” edit mode. 
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________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” 
parameters, timing channel set-points and shift data to the M4510 or 
S4520 from the set-up “Data File”.  This function is accessed from 
the “File” menu and the user is given the choice of the following 
options: 
 

 
 
M4510 PLC:  This option downloads set-up parameters, machine 
timing set-points and shift data to the M4510, only. 
 
S4520 Motion Control:  This option downloads set-up and tuning 
parameters to the S4520 Motion Control Board, only 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
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________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, timing channel set-points and shift data.  
This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.   
 
2) This displays the “Print Setup” dialog box, allowing the user to 

select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.   

 
Note: This function makes use of the windows print manager, which 
allows the user to continue with their work while the document is 
being printed. 
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________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
• Edit the Set-Up Passcode. 
 

 
 
 
________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file.  This allows the user the ability to 
make any necessary changes to the set-up parameters while offline 
with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
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________________________________________________________ 
4.3.2 SET-UP COMM PORT 
 
This function allows the user to specify the serial communications 
port and rate to communicate with the M4510.  The PROG and 
MOTION communicates at 9600 baud.   
 

 
 
The option to select the 19200 baud rate is to allow the user to 
communicate via the S4516 serial communications board. In most 
cases, the user will only need to specify the communications port and 
leave the baud rate at 9600.   
 
If communication problems occur, make sure there is a secure 
connection from the PC to the PLC.  Then check the Comm port.  In 
most cases, the user will only need to select a new Comm port.  If 
communication problems persist, there may be another program 
causing a conflict with the port.  Check the port configuration from 
the “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT SET-UP PASSCODE 
 
The edit “Set-up Passcode” is an “Online” function only.  This allows 
the user the ability to directly change the value of the “Set-up 
Passcode”. 
 
Once selected, an input box is displayed, allowing the user to view 
the current “Passcode” setting and to change the value if necessary.   
 

 
 
If the passcode is set to zero, passcode entry is disabled.  The operator 
can press the Set-up key on the Keypad/Display and simply press the 
<ENTER> key to gain access to the set-up parameters without having 
to enter a zero.  
 
If the value of the “Passcode” is set somewhere between 1 and 
65,000, “Passcode Entry” is enabled.  This requires the operator to 
enter in the “Correct” passcode to gain access to the set-up 
parameters. 
 
Note:  Passcode entry is only in effect when the “Set-up Enable” 
selector switch is in the “Disable” position. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
 

 
 
 
________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 
Once invoked, the set-up program will prompt the user to select a 
program.  The setup program will then attempt to communicate with 
the M4510.  If unsuccessful, a warning message will be displayed, 
prompting the user to either “Retry” or “Cancel” the operation.  The 
“Target Board Interface” window will then be displayed.
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to go “Online” with either the M4510 or 
S4520.  This is accessed by the “View” menu, by selecting “Online 
Data” or by simply pressing the “F3” function key. 
 
Note:  The user can be toggled between “Offline” and “Online” by 
simply double clicking on the “Online” or “Offline” panel displayed 
in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will to open the Comm port and 
attempt to communicate with the processor.  If unsuccessful, a 
warning message will be displayed prompting the user to either 
“Retry” or “Cancel” the operation.  If the operation is canceled and 
communication with the processor cannot be established the system 
will be placed in an “Offline” mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  All 
values displayed in “Offline” edit mode reflect the actual values 
contained in the currently loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will cease communication with the 
processor and close the Comm port. 
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________________________________________________________ 
4.5 THE BODYMAKER MENU 
 
The “Bodymaker” menu allows the user to select one of five different 
Display/Set-up windows, used to modify set-up parameters, view shift 
data, adjust timing channel set-points or receive feedback about the 
current status of the control system 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item, and the selected window is displayed and the name 
is changed in the title bar. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE BODYMAKER MAIN DISPLAY WINDOW 
 
The bodymaker “Main Display” window is used to display the 
general state of the control system.  This window is selected from the 
“Bodymaker” menu. 
 

 
 
The following is a list of the functions of the “Main Display” 
window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4510, as well as, 
the current “Online” or “Offline” status of the set-up program.  By 
simply scrolling the display the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine Speed SPM:  This display is only active while “Online” 
and displays the current speed of the machine in “Strokes Per 
Minute”. 
 
Machine Position:  This display is only active while “Online” and 
displays the current position to the main crank resolver in degrees. 
 



SECTION 4 
WISVCUP - WINDOWS BASED  
SET-UP PROGRAM REFERENCE 

 
HSL-WISVCUP User’s Manual SYSTEMS Electronics Group 

 
- 52 - 

________________________________________________________ 
4.5.2 THE BODYMAKER SET-UP PARAMETERS WINDOW 
 
The bodymaker “Set-up Parameters” window is used to view and 
adjust the set-up parameters.  This window is selected from the 
“Bodymaker” menu. 
 

 
 
Brake Wear Compensation:   
1) Brake Wear Compensation Enable:  This is used to enable 

or disable the brake wear compensation. To disabled, click the 
checkbox and remove the checked state. If the compensation is to 
be enabled, click the checkbox to set the checked state. 

 
2) Desired BDC Stop Position (Low Speed):  This is the 

desired stopping location (in degrees) for a BDC stop at low speed 
when the brake wear compensation is enabled.  This is typically 
set to 000 degrees (back dead center).   

 
 Note:  This parameter is automatically disabled whenever “Brake 

Wear Compensation” is disabled. 
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3) Desired BDC Stop Position (Low Speed):  This is the 
desired stopping location (in degrees) for a BDC stop at high 
speed when the brake wear compensation is enabled.  This is 
typically set to 000 degrees (back dead center).   

 
 Note:  This parameter is automatically disabled whenever “Brake 

Wear Compensation” is disabled. 
 
4) Maximum Allowed Stopping Response:  This defines the 

maximum allowed brake response before the "Brake Response 
Too Long" alarm is generated. If the actual brake response 
(number of degrees from when the brake is activated to the 
position where the press ends up at rest when a BDC stop is 
performed) is longer than this number, the alarm is generated. If 
the actual brake response is less, the alarm is not generated. Set 
this parameter to the value where the brake response is considered 
too long and service to the brake should be performed (typically 
270 to 300 degrees). 

 
Bodymaker Running Speeds:  
1) Running Bodymaker Low Speed (SPM):  This is the speed 

(in strokes per minute) the bodymaker will run when in low (inch) 
speed. 

 
2) Running Bodymaker High Speed (SPM):  This is the speed 

(in strokes per minute) the bodymaker will run when in high 
(cont./single) speed. 

 
 
Trimmer Speed References:  
1) Trimmer Maximum Speed (CPM):  The "Trimmer Maximum 

Speed" is used to scale the 0-10VDC analog output such that 
when the bodymaker is running at the speed entered the analog 
output is 10 volts. This is typically set to the running high speed 
of the Bodymaker or slightly higher. 

 
2) Trimmer Idle Speed (CPM):  This parameter determines the 

speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  

 
Note:  This parameter is used to provide the speed reference 
when the bodymaker speed is zero. When the bodymaker is 
running, the trimmer speed reference is proportional to the speed 
of the bodymaker.  
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________________________________________________________ 
4.5.3 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming 
command menus.  From this window, the user can view or adjust the 
following parameters: 
 
• Adjust Timing Channel set-points. 
• Set the Main Crank resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 
The following parameters are displayed at the bottom of this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the 
main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank 
resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
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Scale:  This is the scale factor of the resolver or the number of 
divisions in one revolution. 
 
Zeroing the Machine (setting the resolver offset):  To set 
machine zero, perform the following: 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4510.   
 
2) From the “Bodymaker” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.   
 
4) Observe the “Position” field at the bottom of the window.  Verify 

that as the machine is rotated forward, that the position increases 
linearly from 0 through 359 degrees.  If not, swap the S1 and S3 
leads at the resolver connector on the M4510.  Then, verify that 
the position does indeed increase with forward movement. 

 
5) Position the machine at back dead center. 
 
6) Auto zero the resolver by entering “0” in the “Resolver Offset” 

field and clicking the “Set Offset” command button.  A message 
box will appear, prompting the user to confirm their choice.  
Select “Yes” to set the resolver offset. 

 
7) The M4510 will calculate the actual offset value required to make 

this the “0” position.  The new offset value will be displayed in 
the “Offset” field and the position will then read zero. 
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Adjusting the Timing Channel Setpoints:  To set any of the 
timing signal setpoints, perform the following: 
 
Note:  Any changes made to the timing channel setpoints will be 
saved as part of the setup data file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4510.   
 
2) From the “Bodymaker” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  
 
4) Setpoints for a particular channel are either entered in the field or 

adjusted by using the increment/decrement controls. 
 

Note:  Only one set-point per channel is used.  
 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired 

channel number into the “PLS Channel” field.  Click the “Recall 
Channel” command button to recall the set-point.  Click the 
“Clear Channel” command button the completely clear the 
selected channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” 

setpoints have the same setting, the set-point will be displayed as 
“*****”. 

 
Resetting the PLS Configuration:  As an aid to the user, the 
current PLS configuration is displayed as part of this window.  The 
PLS configuration should only need to be reset if a new module has 
been installed.  To reset the PLS configuration, click the “Reset PLS 
Config” command button.  This function only resets the PLS 
configuration to the default settings for the bodymaker. 
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________________________________________________________ 
4.5.4 THE SHIFT DATA WINDOW 
 
This window is used to view the Current Shift data, Last Shift data, 
Low and High speed brake responses and to invoke the “End of Shift” 
data transfer. 
 

 
  
Current Shift - Total Good Cans: This is the total number of 
good cans produced so far into the current shift. This is essentially a 
can counter. 
 
Current Shift - Total Short Can Faults: This is the total number 
of short can faults that have occurred so far into the current shift. 
 
Last Shift - Total Good Cans: This is the total number of good 
cans produced in the last (previous) shift. This is essentially a can 
counter. 
 
Last Shift - Total Short Can Faults: This is the total number of 
short can faults that occurred in the last (previous) shift. 
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Note: The current shift data is transferred to the "Last shift" data 
when the end of shift input transfers from a "0" to a "1". This can be 
at the end of either an 8 or 12-hour shift. This data can also be reset 
from this menu by clicking the “Transfer Data” command button. 
 
Lo Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (Lo) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at Low speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Hi Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (hi) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at high speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Note:  The brake response for both high and low speeds is updated 
after each BDC stop. 
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________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, the states of the timing channels, as 
well as states of the M4510 are shown.  This includes the interrupt 
inputs (IN0 and IN1), the analog I/O and the resolver.  These values 
are displayed as read by the M4510 processor. 
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________________________________________________________ 
4.6 THE SERVO CUPFEED MENU 
 
The “Servo Cupfeed” menu allows the user to select one of four 
different Display/Set-up windows, used to modify set-up parameters 
and tune the servo cupfeed motor. 
 
Prior to making this selection, make sure an RS-232 SYSdev cable is 
connected from the COM port on the computer to the MOTION port 
on the S4520 motion control board. 
 

 
 
Once a window menu item is selected, the selected window is 
displayed and the name is changed in the title bar. 
 
Note:  In general, “Read” only variables are displayed in blue with a 
gray background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed will have an associated increment and 
decrement control.  The user can either click on the desired parameter 
and enter in a new value, or use the increment or decrement control to 
change the value by one unit. 
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________________________________________________________ 
4.6.1 THE CUPFEED SET-UP PARAMETERS WINDOW 
 
This selection is used to set the cupfeed set-up parameters. When 
selected, the servo cupfeed “Set-up Parameters" window is invoked.  
 

 
 
The servo cupfeed “Set-up Parameters" window contains the 
following selections: 
 
Cupfeed Stop Position at Short Can (Counts):  This is the 
position the cupfeed cam will stop at when a short can alarm occurs. 
This should be set to the trailing edge of the short can check timing 
signal such that when a short can is detected, the cupfeed cam will 
immediately stop (and not continue following the ram). 
 
Max Error for "Out of Sync" Disable: This is the maximum 
amount of error allowed between the ram and the cupfeed to enable 
the cupfeed to open. If the running error is less than this threshold, the 
cupfeed is in sync with the ram and the cupfeed can be opened. If the 
running error is greater than this threshold, the cupfeed will be 
disabled. 
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Max Error to Enable Cupfeed Synchronization: This threshold 
is used to synchronize the cupfeed with the main crank when the 
clutch is activated. Once the main crank is within this error threshold 
of the cupfeed, the cupfeed will than sync in with the main crank and 
then track the ram using the PID servo loop. 
 
Max Error for "Following Error" Alarm: This is the maximum 
amount of error allowed between the ram and the cupfeed before a 
"Following Error" fault is generated. This is enabled once the cupfeed 
is in sync with the main crank. The "Following Error" alarm is 
filtered to allow short errors in excess of this threshold to occur 
without generating the alarm. This threshold is primarily used to 
detect instability in the cupfeed servomotor or peak current limit 
conditions (excessive frictional loads in the cupfeed). 
 
 
________________________________________________________ 
4.6.2 THE CUPFEED TUNING WINDOW 
 
This selection is used to tune the servo cupfeed motor. When selected, 
the servo cupfeed “Tuning" window is invoked.  
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Cupfeed Servo PID Gains: 
Proportional (P) Gain:  The proportional gain is used to create an 
error term, which is "proportional" to the difference between the main 
crank position and servo motor position. For a specific amount of 
error, the higher the (P) gain, the higher the torque generated to null 
the error.  
 
Note:  By itself, the (P) term cannot null the error to zero since a 
torque is only generated when there is a difference between the main 
crank position and servomotor. 
 
This (P) gain is used in conjunction with the other gains to define the 
system stability and responsiveness. A higher the (P) gain will cause 
the servo motor to be more responsive. Too high of a (P) gain will 
cause the motor to become unstable (oscillate) because the system 
cannot respond quickly enough. Excessive current will also be drawn 
which is undesirable. Too low of a gain will cause excessive 
following error to the point of instability depending on where the (I) 
gain is set. The (P) gain can also be used to overcome high frictional 
loads (higher (P) for higher friction). 
 
Integral (I) Gain:  The integral gain is used to create an error term, 
which is proportional to the cumulative difference (error) between the 
main crank position and servo motor position. Thus for a fixed 
amount of error, the torque generated due to the integral error term 
will continue to increase at a rate proportional to the (I) gain. The 
higher the integral error term, the faster the torque generated to null 
the error will increase. This term is used to null a fixed error to zero 
since a torque of whatever amplitude will be generated to null the 
error to zero.  
 
Note:  Without the other gains ((P) and (D)), the system would be 
unstable. 
 
As with the (P) gain, a higher (I) gain will cause the servo motor to be 
more responsive.  
 
Note:  Too high of an (I) gain will cause the motor to be unstable 
(oscillate) because the system cannot respond quickly enough. Too 
low of an (I) gain will cause excessive following error since at low (I) 
gains, the (P) gain would than be mostly responsible to null the error. 
The system will not be unstable if the (I) gain is set to zero. 
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Derivative (D) Gain:  The derivative (D) gain is used to create an 
error term, which is proportional to the rate of change of error 
between the main crank position and servo motor position. Thus for a 
fixed amount of error, the torque generated due to the derivative error 
term will be zero (rate of change is zero). This error term is only 
generated when the amount of error is changing. The higher the rate 
at which the error changes, the higher the derivative error term. This 
term is primarily used to stabilize the servo loop. It is used to reduce 
ringing in under-damped responses or to provide fundamental 
stability to loops that would otherwise be unstable. 
 
There is a definite compromise between to much and not enough (D) 
gain. With too low, the system may be marginally to completely 
unstable. Excess ringing with a corresponding longer settling time to 
a step response will occur if the (D) gain is too low. If the (D) gain is 
too high, system response will be reduced and high frequency 
oscillations may occur.  This will not cause instability but higher 
current will be drawn and excessive high frequency torque will be 
applied to the load. 
 
 
Cupfeed Actual Running Error: 
Instantaneous Absolute Error (Counts): This is the 
instantaneous absolute (magnitude) difference between the main 
crank position and the cupfeed cam position. 
 
Positive Peak Error (Counts): This is the maximum positive peak 
error detected as the cupfeed cam rotates. This is updated once every 
1.5 seconds while the machine is running. 
 
Negative Peak Error (Counts): This is the maximum negative 
peak error detected as the cupfeed cam rotates. This is update once 
every 1.5 seconds while the machine is running. 
 
The above diagnostic error data can be used to judge how well the 
cupfeed cam motor is tuned and how well the cupfeed cam is tracking 
the main crank. 
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Servo Amplifier Test Mode: 
When selected, the user is prompted to confirm their choice to enable 
servo amplifier test mode. If enabled, the servo amplifier test outlined 
in the trouble-shooting section (section 7.3 – Cupfeed Cam Does Not 
Move) can be performed.  
 
Note:  This is only used to verify the servo amplifier and motor. The 
machine cannot be run with the test mode enabled.  For this reason 
due caution must be used when performing this test. 
 
WARNING!!  IN THE TEST MODE, THE SERVOMOTOR IS 
EXCLUSIVELY CONTROLLED WITH THE "TEST/OFFSET" 
(POT 4) ON THE B25A20. STAY CLEAR OF THE CUPFEED 
CAM AT ALL TIMES WHEN IN THE SERVO AMPLIFIER 
TEST MODE!! 
 
 
________________________________________________________ 
4.6.3 THE CUPFEED DIAGNOSTICS WINDOW 
 
This window displays both the main crank position (0 to 4095) and 
cupfeed servo motor position (0 to 4095). This is useful for trouble-
shooting purposes to observe the resolver feedback is correct for both 
(correct direction and linear). 
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This window contains the following selections: 
 
Actual Main Crank Position (0-4095):  This is the current main 
crank position with reference to a scale factor of 4096 for one 
complete revolution of the main crank. This is used as the primary 
reference for the cupfeed PID servo loop. 
 
Main Crank Offset:  This is set automatically when the main crank 
position is zeroed. 
 
Actual Cupfeed Cam Position (0-4095):  This is the current 
cupfeed cam position with a scale factor of 4096 for one complete 
revolution of the cupfeed cam. This is used as the feedback to the 
cupfeed PID servo loop. 
 
Cupfeed Cam Offset (0-4095):  This is set automatically when the 
cupfeed is initially timed after power up and is calculated based on 
the "Cupfeed Home Position". 
 
Cupfeed Cam Home Position:  This is the position of the cupfeed 
cam when a cup is loaded into the cup locator. The cupfeed cam is 
timed such that it will be in sync with the main crank and load the cup 
when the ram has just opened up.  The position is set when the user 
presses the "Home Cupfeed Cam" push-button inside the HSL-
WISVCUP enclosure.  
 
Main Crank-to-Cupfeed Absolute Error:  This is the absolute 
(magnitude) difference between the main crank position and the 
cupfeed cam. When the PID servo loop is active, the torque applied to 
the cupfeed cam motor will be a function of this error. 
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________________________________________________________ 
4.6.3 THE ACQUIRE DATA SIGNATURES WINDOW 
 
This selection is used to acquire the current, error, actual cam profile, 
and reference profile data for one stroke. This data is sampled once 
every millisecond for one complete stroke and uploaded from the 
processor. This is used for tuning while the machine is running as 
well as trouble-shooting.  
 

 
 
The total number of samples taken in one stroke is equal to the period 
in milliseconds, up to a maximum of 255 samples.  This value is 
displayed in the “Data Samples per Stroke” field. 
 
The following functions can be executed from this window: 
 
Acquire Data:  By clicking this command button, the S4520 
initiates collecting the data signatures for one stroke.  Once 
completed, the data collected is displayed in the chart to the right.   
 
Note:  The “Acquire Data” function is only enabled when the set-up 
program is “Online” with the processor. 
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Print Data:  By clicking this command button, the user can obtain a 
printout of the data displayed.  Once executed, the “Print Setup” 
dialog box is displayed, allowing the user to choose a printer device, 
as well as, define the size and orientation of the paper. This printout 
also displays the current settings of the PID gains.   
 
Save Data:  By clicking this command button, the user can save the 
data to a “Cupfeed Data” file.  This allows the user to easily save 
different sets of acquired data signatures. 
 
Open Data:  By clicking this command button, the user can open an 
existing “Cupfeed Data” file.  This allows the user to examine 
previously saved acquired data signatures, while not “Online” with 
the processor.  
 
Export Data:  By clicking this command button, the user can export 
the displayed data to a “Text” file format.  This allows the data to be 
easily used by other windows programs such as Microsoft Excel or 
Microsoft Word.  Any program that can open a “Text” file format, 
can have access to this data. 
 
Note:  Data displayed can also be copied to the windows clipboard.  
Simply select the desired data, press “Ctrl+C” and the data will be 
copied to the windows clipboard.  The user can then open another 
windows program, such as Microsoft Excel, and paste the contents of 
the clipboard into the new worksheet. 
 


